
Click Help Topics for a list of Help topics.



Install Driver

This dialog box prompts you for the disk or the drive and directory where driver information or a driver file is 
located.
Type the appropriate drive letter and directory path in the text box. If the driver file or information is located on a
floppy disk, insert the disk in drive A, and then click OK.
If you are not sure where the driver file or information is located, (for example, if you want to use a driver that is 
located on a network drive and you are not sure which directory it is in), click Browse.
If the driver requires additional settings to work properly with Windows NT, a setup dialog box appears. In the 
setup dialog box, specify the settings as described in the manual for your device.



Browse

Use this dialog box to find and select the drive and directory where the driver file is located.
Open the Drives list, and then select the drive that contains the driver file. The Directories list displays the 
directories on the selected drive.
Open the Directories list, and then select the directory that contains the driver file.



Specifying Basic Serial-Port Settings

Use the Settings dialog box to specify the baud rate, data bits, parity, stop bits, and flow-control settings for 
the selected serial port. 

To specify serial-port settings

1 In Control Panel, double-click the Ports icon. 
2 Click the port and then click Settings. 
3 To display the options for each setting, click the arrow to the right of each box.
4 Set the options to match the device connected to the port.

For information about the correct settings, see the documentation supplied with the device.
5 Click OK. 
6 Click Close. 

Tip
For help with the Settings dialog box, click Help or press F1 while using the dialog box. 

See Also

Specifying Advanced Serial-Port Settings



Specifying Advanced Serial-Port Settings

Use the Advanced Settings dialog box to specify an I/O address and an interrupt request line (IRQ)  for your 
serial port, change the port number of a port, and specify to use buffering of incoming data to increase 
performance.

To set advanced port options

1 In Control Panel, double-click the Ports icon.
2 Click the port and then click Settings.
3 Click Advanced.
4 If your serial-port hardware uses address values other than the values that Windows NT detects, change the 

base I/O address.
5 If you are using a computer that cannot access COM1 and COM3 or COM2 and COM4 simultaneously, and you 

want to use these ports, specify a unique IRQ number for each port.
6 Change the port number of a port (for example, change COM3 to COM253).
7 To use buffering of incoming data and enable some additional functionality on newer COM ports, select the 

FIFO Enabled check box.
8 Click OK.
9 Any changes you make will not take effect until you restart Windows NT. To make your changes take effect 

now, click Restart Now.

Tip
For help with the Settings and Advanced Settings dialog boxes, click Help or press F1 while using the 

dialog boxes. 

See Also

Specifying Basic Serial-Port Settings



Ports

Enables you to specify the communications settings for a selected serial (COM) port. To specify communications 
settings, click the name of the port and then click Settings. 
To add a new serial port to your system, click Add. To delete a port, click it in the Ports box and then click 
Delete.

See Also

Specifying Basic Serial-Port Settings



Port Settings

Use this dialog box to specify the communications settings for the selected serial (COM) ports. 
For more information, click one of the following buttons: 
 Baud Rate
 Data Bits 
 Parity
 Stop Bits 
 Flow Control
 Advanced Button 

See Also

Specifying Basic Serial-Port Settings



Advanced Port Settings

Use this dialog box to specify the I/O addresses and the interrupt request line (IRQ) for the selected port, change
the port number of a port, and specify to use buffering of incoming data to increase performance. 
If you are adding a new port, the settings for Base I/O Port Address and IRQ that appear are the 
recommended choices, not default settings. In the Base I/O Port Address box, the first two addresses, 3F8 
and 2F8, are usually reserved for COM1 and COM2. If you use these addresses for a port you have created, your 
COM1 or COM2 ports may not function.
For more information, click one of the following buttons: 
 COM Port Number
 Base I/O Port Address
 Interrupt Request Line (IRQ)
 FIFO Enabled

See Also

Specifying Advanced Serial-Port Settings



COM Port Number

Enables you to change the port number of a port. Windows NT supports a maximum of 256 COM ports. Any new 
ports that are added must be between 3 and 256, since COM1 and COM2 are the only two reliably directed COM 
ports recognized by most BIOS.



FIFO Enabled

Enables the serial chip (UART) to use on-chip buffering of incoming data and to allow some additional 
functionality for newer COM ports.



Baud Rate

Enables you to select a rate for how fast you want information transferred through the port. 



Data Bits

Enables you to select the number of data bits you want to use for each character. Most characters are 
transmitted in 7 or 8 data bits. 



Parity

Enables you to select a method for error checking. 



Stop Bits

Enables you to select a number for the time between transmitted characters. Stop bits are not actually bits; they
are the timing units between bits. 



Flow Control

Enables you to select a method for controlling the flow of data. Xon/Xoff is the standard for the software method.
Click Hardware if your device controls data flow. 



Advanced Button

Displays the Advanced Settings dialog box, which enables you to specify advanced options for the selected 
port.



Base I/O Port Address

Enables you to change the base port address for the COM port you want to use by entering an I/O address. Use 
this option only if the device connected to your serial port uses an address value that differs from the detected 
value displayed in the text box. See the manual for your device for information on the base port address that it 
uses. 



Interrupt Request Line (IRQ)

Enables you to assign unique interrupt request lines (IRQ) for each serial port. This enables you to use COM ports
1 and 3 and/or 2 and 4 simultaneously on a computer that normally does not support this capability. You can 
specify a value between 2 and 15.
Before assigning IRQ numbers to serial ports, determine which interrupts are used by the devices connected to 
the serial ports and which ones are not being used by other cards or boards installed in your computer. You may 
need to adjust your serial card to use available interrupts. For information, see your serial-card documentation.



Using the UPS Tool

The UPS option in Control Panel enables you to set various options for controlling how UPS services work on a 
computer. The actual options for configuring the UPS service depend on the specific UPS hardware installed on 
your system. The options you can set with the UPS tool include: 

The serial port where the UPS device is connected.
Whether the UPS device sends a signal if the regular power supply fails, if battery power is low, or if the 

UPS device allows remote shutdown.
The time intervals for maintaining battery power, recharging the battery, or sending warning messages 

after power failure.

See Also

Installing UPS Services
Configuring the Uninterruptible Power Supply (UPS)



Installing UPS Services

You can use the UPS tool to turn on or off UPS services for a computer.

To install UPS for a computer

1 In Control Panel, double-click the UPS icon. 
2 In the UPS dialog box, select the Uninterruptible Power Supply Installed On check box, and then specify 

the serial port where the UPS battery is connected.
The other options in this dialog box are not available until you select this check box.

To turn off UPS for a computer
 In the UPS dialog box, click to clear the Uninterruptible Power Supply Installed On check box.

To start the UPS services 
 In Control Panel, double-click the Services icon, click UPS in the Services list, and then click Start.



Configuring the Uninterruptible Power Supply (UPS)

You can use the UPS option in Control Panel to configure various options for the UPS services.

To configure UPS options

1 In the UPS dialog box, select the Uninterruptible Power Supply Is Installed On check box, and then 
specify the serial port where the UPS battery is connected. The other options in this dialog box are not 
available until you select this option.

2 If the UPS device on your system can send a message if the power supply fails, select the Power Failure 
Signal check box. This setting corresponds to the CTS (clear-to-send) cable signal for the UPS serial port 
connection.

3 If the UPS device on your system can send a warning when battery power is low, select the Low Battery 
Signal check box. This setting corresponds to the DCD (data-carrier-detect) cable signal for the UPS serial 
port connection.

4 Next to the Remote UPS Shutdown check box, click Positive or Negative to specify the interface voltage. 
To enable remote shutdown, select the Remote UPS Shutdown check box. This setting corresponds to the 
DTR (data-terminal-ready) cable signal for the UPS serial port connection.

5 For each item that is selected in the UPS Configuration group, under UPS Interface Voltages, click Positive
or Negative. This setting defines how your UPS device communicates with the UPS service based on pin 
settings for the COM port. For information about making this choice, see the documentation for your UPS 
device. 

6 In the Expected Battery Life box, specify the time in minutes that the system can run on battery power. 
The range is 2 to 720 minutes; the default is 2 minutes.

7 In the Battery Recharge Time box, specify the time in minutes that battery must be recharged for every 
minute of run time. The range is 1 to 250 minutes; the default is 100 minutes for each minute of battery run 
time.

8 In the Time Between Power Failure box, specify the time, in seconds, between when a power failure 
occurs and when the first message is sent to notify users. The range is 0 to 120 seconds; the default is 5 
seconds.

9 In the Delay Between Warning Messages box, specify the interval, in seconds, between messages sent to 
notify users of a power failure and to advise them to stop using the computer. The range is 5 to 300 seconds; 
the default is 120 seconds.

10 Click OK.

Important
If the battery can accept a signal from the UPS service telling it to shut down, you must specify the correct 

interface voltage, even if you do not enable remote shutdown. If the voltage is set incorrectly, some UPS devices 
may shut down your computer immediately upon loss of power.

You can also configure the UPS option to execute a command file immediately before system shutdown. 
For example, such a file might run a command to close remote connections. This command file must execute within 
30 seconds. Failure to complete execution in 30 seconds jeopardizes the safe shutdown of your Windows NT 
computer.

To set up the UPS service to execute a file before system shutdown

1 In the systemroot\System32 directory, create a command file with one of the following file extensions:  
  .bat, .cmd, .exe, or .com.

2 Select the Execute Command File check box.
3 In the UPS dialog box, type the name of the file in the File Name box.



UPS

Use the UPS dialog box to configure options for the uninterruptible power supply. This dialog box appears when 
you double-click the UPS icon in Control Panel.
For more information, click one of the following buttons: 
 UPS Installed On
 Power Failure Signal
 Low Battery Signal
 Remote UPS Shutdown
 UPS Interface Voltages
 Execute Command File
 Expected Battery Life
 Battery Recharge Time
 Time Between Power Failure and Warning
 Delay Between Warning Messages

See Also

Configuring the Uninterruptible Power Supply (UPS)



Execute Command File

Enables you to configure the UPS option to execute a command file immediately before system shutdown. For 
example, such a file might run a command to close remote connections. This command file must execute within 
30 seconds. Failure to complete execution in 30 seconds jeopardizes the safe shutdown of your Windows NT 
computer.



Power Failure Signal 

Indicates whether the UPS device on your system can send a message when power fails. 
This setting corresponds to the CTS (clear-to-send) cable signal for the UPS serial port connection.



Low Battery Signal

Indicates whether the UPS device on your system can send a warning when battery power is low
This setting corresponds to the DCD (data-carrier-detect) cable signal for the UPS serial port connection.



Remote UPS Shutdown

Indicates whether remote UPS shutdown is enabled.
This setting corresponds to the DTR (data-terminal-ready) cable signal for the UPS serial port connection.



Uninterruptible Power Supply Installed on Port

Indicates whether UPS is installed.



Time Between Power Failure and Warning Message

Indicates the time interval in seconds between when a power failure occurs and when the first message is sent 
to notify users.
The range is 0 to 120 seconds; the default is 5 seconds.



Delay Between Warning Messages

Indicates the time interval in seconds between messages sent to users after a power failure until the system is 
shut down.
The range is 5 to 300 seconds; the default is 120 seconds.



Uninterruptible Power Supply (UPS)

UPS is a battery-operated power supply connected to a computer to keep the system running during a power 
failure. The UPS service for Windows NT manages a safe system shutdown if the power fails, or keeps the system
running until power is restored or until the system is shut down by an administrator. 



Expected Battery Life

Indicates the time in minutes of the expected life of the fully charged battery.
The range is 2 to 720 minutes; the default is 2 minutes. 



Battery Recharge Time

Indicates the time in minutes for recharging the battery. If you click Power Failure Signal and do not click Low 
Battery Signal, select the time in minutes for Battery Recharge Time. 
The range is 1 to 250 minutes; the default is 100 minutes for each minute of battery run time.



UPS Interface Voltages

Indicates the UPS interface voltage. When you select any UPS Configuration check box, click Positive or 
Negative.



To test your UPS configuration

1 Simulate a power failure by disconnecting the power to the UPS device. 
The computer and peripherals connected to the UPS device should remain operational and a warning message
and/or alert should appear on screen.

2 Wait until the UPS battery reaches a low level, at which point system shutdown should occur.
3 Restore power to the UPS device.
4 Check the system log in Event Viewer to ensure that all actions were logged and that there were no errors.

Note
If the UPS service is configured to run a command file, you should test to ensure that the file's execution 

does not exceed the 30-second time limit. 



Devices

Use this Control Panel option to start or stop devices. For more information, click one of the following buttons:
 Device
 Status
 Startup
 Start button
 Stop button
 Startup button
 HW Profiles button

{button ,AL("CPL_DEVICES_CONFIG")} Related Topics



Device

Lists the available devices. After you select a device, you can stop or start it, configure its startup type, or enable
or disable it in a hardware profile. Note that you can only select one device at a time.



Status

Displays Started when a device is loaded. If this column is blank, it means that no device driver is loaded.



Startup

Labels the current startup type for the listed device, as follows:
Boot, System, or Automatic indicates that the device is started automatically every time the system starts.
Manual allows the device to be started by a user or a dependent device.
Disabled prevents the device from being started by a user.



Start button

Loads the selected device driver.



Stop button

Stops the selected device driver that is currently started. Some devices are essential to system operation and 
cannot be stopped. When such a device is selected, this button is unavailable.



Startup button

Enables you to change the current startup type for the selected device. To change a device's startup type, you 
must be logged on to a user account that has membership in the Administrators local group.



HW Profiles button

Enables or disables the selected device in an existing hardware profile.



Device Startup

Use this dialog box to configure when and how the selected device is started. For more information, click one of 
the following buttons:
 Device
 Startup Type
 Boot
 System
 Automatic

 Manual
 Disabled

{button ,AL("CPL_DEVICES_CONFIG")} Related Topics



Device

Shows the device to be configured.



Startup Type

Enables you to change the device's startup type by clicking one of the following options:
Boot starts the device when the computer starts.
System starts the device after Boot devices when the system starts.
Automatic starts the device automatically after Boot and System devices when the system starts.
Manual allows the device to be started by a user or a dependent device.
Disabled prevents the device from being started by a user, although it can be started by the system.

Caution
Changing the startup type of a Boot or System device can destabilize the system.



Boot

Starts every time the system starts, before any other devices start. Click this option for critical devices essential 
to system operation.



System

Starts every time the system starts, after the Boot devices start. Click this option for critical devices essential to 
system operation.



Automatic

Starts every time the system starts, after the Boot and System devices start. Click this option for devices that 
are not critical for basic system operation.



Manual

Allows the devices to be started by a user or a dependent device.



Disabled

Prevents users from starting the device, although the system can still start disabled devices.



Device Hardware Profiles

Use this dialog box to enable and disable device configurations when you boot the system using specific 
hardware profiles. For more information, click one of the following buttons:

 Device
 Status
 Profile
 Enable
 Disable

{button ,AL("CPL_DEVICES_CONFIG")} Related Topics



Device

Shows the device to be enabled or disabled.



Status

Displays the device status for each listed hardware profile. Displays Enabled when this device is enabled after 
you boot the system using the associated hardware profile. A device can be either enabled or disabled for a 
hardware profile.



Profile

Lists the hardware profiles you can choose at startup. To create hardware profiles and set their order of 
preference, double-click the System option in Control Panel and then click the Hardware Profiles tab.



Enable button

Enables the device for a hardware profile. If this button is unavailable, then the device is already enabled for the 
selected hardware profile.



Disable button

Disables this device for a hardware profile. If this button is unavailable, then the device is already disabled for 
the selected hardware profile.



To enable or disable a device in a hardware profile

1 Click here        to display Devices.
2 Under Devices, click a device.
3 Click HW Profiles.
4 Click the profile to change.
5 Click Enable or Disable.

Tip
To create hardware profiles and set their order of preference, double-click the System option in Control 

Panel and then click the Hardware Profiles tab..

{button ,AL("CPL_DEVICES_CONFIG;Sys_CopyProfile;Dev_EnableDisable")} Related Topics



To start or stop a device

1 Click here        to display Devices.
2 Under Devices, click a device.
3 Click Start or Stop.

Tips
If Started appears in the Status column for a device, it means that the device driver is loaded. If this 

column is blank, it means that the device driver is not loaded.
Some devices are essential to system operation and cannot be stopped. When such a device is selected, 

the Stop button is unavailable.

{button ,AL("CPL_DEVICES_CONFIG")} Related Topics



To set the startup type of a device

1 Click here        to display Devices.
2 Under Devices, click a device.
3 Click Startup.
4 Under Startup Type, click Boot, System, Automatic, Manual, or Disabled.

Note
Changing the startup type of a Boot or System device can destabilize the system.

{button ,AL("CPL_DEVICES_CONFIG")} Related Topics 





Specifies the resources currently used by the hardware. To change a resource setting, double-click the resource 
type for the setting you want to change.
Generally, it is best not to change resource settings manually. When you change settings manually, the settings 
are fixed, and Windows NT will then have less flexibility when configuring other devices.



Changes the value of the setting selected in the Resource Settings box.
If this button is not available, the settings for this hardware cannot be changed. However, you may be able to 
use a different configuration by clicking a different option in the Settings Based On box.



Select this check box if you want Windows NT to determine available resource settings for this hardware. This 
check box is available only if your hardware supports this capability.
If this check box is available, it is best to select it. Windows NT will then have the most flexibility when 
configuring other devices.



Lists which configuration (group of available resource settings) the hardware is currently using. To choose a 
different configuration, click the down arrow.
If you choose a configuration other than the default, the hardware may run more slowly, or some functionality 
may not be available.



Lists any conflicts among the resources shown in the Resource Settings box.



Displays the current value for the resource setting you selected, and lists other values you can choose that will 
work with your hardware. If you choose a setting that is already in use by other hardware, the conflict will be 
listed in the Conflict Information box.



Displays the device(s) currently using the resource displayed in the Value box.
If a device is listed in this box, a hardware conflict will occur if you use the selected resource. If this box reads 
"No devices are conflicting," the resource selected above is available for use.



Installs a default Windows NT driver that will work with your hardware. This option is only available if a 
Windows NT driver exists that works with your hardware. 
Click this option if it is available and you don't have a disk provided by your hardware manufacturer, or if you 
know the disk you have is out-of-date.



Installs a driver from a disk provided by your hardware manufacturer. Click this option if you have a disk that 
came with your hardware.
If you click this option and see a message that there is nothing on the disk to list, it may be that the installation 
files on the disk provided by your manufacturer are not compatible with this version of Windows NT. In this case, 
choose not to install a driver, and install the driver by using the installation program on the disk.



Does not install a driver.
Click this option if you want to install a driver for your hardware later, or if the installation files on the disk 
provided by your manufacturer are not compatible with this version of Windows NT. If you choose this option, you
will not be prompted again for a driver.



Displays a list of devices so you can choose a similar device and install its driver. (For example, you may be able 
to install a standard driver for your type of hardware, or you can choose a similar type of device from the list and
see if its driver will work.)
This option is not recommended if any other options are available.



Console Windows Properties - Options

Console is a Control Panel program that enables you to configure the default appearance of character-based 
windows (consoles) and Command Prompt windows. You can also configure the properties for a specific 
Command Prompt application or shortcut.
The settings you configure using Console apply to all newly-created console windows. The settings you configure 
using command prompt properties apply only to the selected Command Prompt window or to windows invoked 
from the same icon.
 Cursor Size
 Command History
 QuickEdit Mode
 Insert Mode
 Display Options

See Also

Font
Layout
Screen Colors



Cursor Size

Select this option to resize the cursor to either small, medium, or large.



Command History

Select this option to configure the buffer size or number of commands to store, or to eliminate duplicate 
commands in the buffer.



QuickEdit Mode

Select this check box to bypass the Edit menu and use a pointing device (mouse) to cut and paste.



Insert Mode

Select this check box if you want text to be inserted at the cursor. If insert mode is not enabled, text that is typed
at the cursor replaces existing text (overtypes).



Display Options

Select this option to set display options. If you are using an x86-based computer, the command prompt can be 
displayed in either window mode or full-screen mode. By default, the command prompt is displayed as a window 
on your screen.
Risc-based computers do not support full-screen mode. For this reason, the Display Options box does not 
appear in the Options tab if you are using a Risc-based computer.

Tip
 To toggle between window mode and full-screen mode on x86-based computers, press ALT+ENTER.



Console Windows Properties - Font

You can choose to display different fonts and font sizes for character-based windows (consoles) and command 
prompt windows. Default fonts are saved based on the title of the window. When you change fonts, the window 
size changes to accommodate the new font size.
 Window Preview
 Size
 Font
 Bold Fonts
 Selected Font

See Also

Options
Layout
Screen Colors



Font

Use this option to select the type of font you want to display.



Size

Use this option to select the font size you want to display.



Bold Fonts

Select this check box to use bold fonts. If bold fonts are not available, the check box appears dimmed.



Selected Font

Use this window to view how the selected font will look in the console window.



Window Preview

Use Window Preview to see how the current window’s size will change based on the settings you have 
entered. Later, you can resize the window up to the maximum screen buffer size.



Console Windows Properties - Layout

You can specify where console windows are set up on the screen, the size of the window, and the amount of 
information the screen buffer contains.
 Window Preview
 Screen Buffer Size
 Window Size
 Window Position

See Also

Options
Font
Screen Colors



Screen Buffer Size

Use this option to specify settings for the width and height of the screen. The width setting determines the 
number of characters in each line. The height setting determines how many lines are stored in memory. If the 
current window size is smaller than the screen buffer size settings, scroll bars are displayed so you can scroll 
back through the information. 
You cannot resize a window to be larger than the area set by the screen buffer settings. On x86-based 
computers, if you switch to full screen display, Windows NT will display the number of lines (25, 43, or 50) 
supported by your hardware that is closest to your window mode configuration.



Window Size

Use this option to specify the visible width and height, in characters, of the window.



Window Position

Use this option to specify settings for the left and top position of the window. If you want the system to position 
the window, select the Let System Position Window check box.



Console Windows Properties - Screen Colors

You can specify the color of the text and background of all character-based windows (consoles) and command 
prompt windows. You can also specify the text and background color of pop-up windows that originate from the 
command prompt. Pop-up windows (for example, command history windows) are smaller character-based 
windows that present information to choose from.
To choose colors for screen text, screen background, pop-up text, or pop-up background, select the element you 
want to change, and then choose the color you want. The selections you make appear in the Selected Screen 
Colors or Selected Popup Colors box.
 Screen Text
 Screen Background
 Popup Text
 Popup Background

To increase or decrease the amount of primary color used in a color, click Selected Color Values, and then 
specify new numbers from 0 to 255 in the Red, Green, and/or Blue boxes.

See Also

Options
Font
Layout



Screen Text

Select this option to change the color of the screen text in a window. You can view the current setting in the 
Selected Screen Colors box.



Screen Background

Select this option to change the color of the screen background in a window. You can view the current setting in 
the Selected Screen Colors box.



Popup Text

Select this option to change the color of the text in a pop-up window. You can view the current setting in the 
Selected Popup Colors box.



Popup Background

Select this option to change the color of the background in a pop-up window. You can view the current setting in 
the Selected Popup Colors box.



To change the size of the cursor

1 Click here     to display Console properties.
2 Click the Font tab.
3 In the Cursor Size box on the Options tab, specify a cursor size.

See Also

Changing Command History Settings
Changing Window Mode Settings
Changing Display Option Settings



To change the command history settings

1 Click here     to display Console properties.
2 In the Command History box of the Options tab, specify a buffer size, and then specify the number of 

buffers to use.

Tips
To eliminate the listing of duplicate commands in command history, select the Discard Old Duplicates 

check box.
To view the command history, use the UP ARROW or DOWN ARROW keys.

See Also

Changing Cursor Size
Changing Window Mode Settings
Changing Display Option Settings



Enables text to be inserted at the cursor. If Insert mode is not enabled, text that is typed at the cursor replaces 
existing text (overtypes).



Enables you to use the mouse to cut and paste, bypassing the Edit menu.



To change window mode settings

1 Click here     to display Console properties.
2 On the Options tab, select the QuickEdit Mode or Insert Mode check box.

See Also

Changing Cursor Size
Changing Command History Settings
Changing Display Option Settings



To change display option settings

1 Click here     to display Console properties.
2 In the Display Options box on the Options tab, select window mode or full-screen mode.

Notes
If you are using an x86-based computer, the command prompt can be displayed in either window mode or 

full-screen mode.
Risc-based computers do not support full-screen mode.
To toggle between window mode and full-screen mode on x86-based computers, press ALT+ENTER.

See Also

Changing Cursor Size
Changing Command History Settings
Changing Window Mode Settings



To change fonts for Window mode

1 Click here     to display Console properties.
2 Select the Font tab.
3 In the Font box, select a font.
4 In the Size box, select a font size.
5 To use bold fonts, select the Bold Fonts check box.
6 In the Window Preview box, view how the current window’s size will change based on the font and font size 

you have selected.

Notes
Default fonts are saved based on the title of the window. When you change fonts, the window size changes

to accommodate the new font size.
You can resize the window up to the maximum screen buffer size.

See Also

Changing the Layout
Changing Colors



The height setting determines how many lines are stored in memory.



The width setting determines the number of characters per line.



To change the screen layout

1 Click here        to display Console properties.
2 Click the Layout tab.
3 In the Screen Buffer Size box, specify settings for the width and height of the screen.
4 In the Window Size box, specify settings for the visible width and height of the window.
5 In the Window Position box, specify settings for the initial left and top position of the window.

Notes
To have the system position the window, select the Let System Position Window check box.
Scroll bars are displayed if the current size of the window is smaller than the screen buffer size settings. 
You cannot resize a window to be larger than the area set by the screen buffer settings. 
On x86-based computers, if you switch to full screen display, Windows NT will display the number of lines 

(25, 43, or 50) supported by your hardware that is closest to your window mode configuration.

See Also

Changing Fonts for Window Mode
Changing Colors



To change colors

1 Click here     to display Console properties.
2 Click the Colors tab.
3 Choose colors for screen text, screen background, pop-up text, or pop-up background by selecting the element

you want to change, and then selecting the color you want.

See Also

Changing Fonts for Window Mode
Changing the Layout 



Services

Use this dialog box to start, stop, pause, or continue each of the services available on the computer, and to pass 
startup parameters to the service.
For more information, click one of the following buttons:
 Service
 Status
 Startup
 Start
 Stop
 Pause
 Continue
 Startup
 HW Profiles
 Startup Parameters

{button ,AL("CPL_SRVMNG_ServicesPR;SM_SVC_Default")} Related Topics



Service

Lists the installed services. Select a service and then click the appropriate button.



Status

Shows the status of a service, as follows:
Started
Paused
Stopped (represented by a blank entry)



Startup

Shows the startup type for a service, as follows:
Automatic (service starts every time the system starts)
Manual (service can be started by a user or a dependent service)
Disabled (service cannot be started)



Start

Starts a service that is stopped. Optionally, to pass startup parameters to the service, type text in the Startup 
Parameters box and then click Start.



Stop

Stops a service that is running. If another service is dependent on the service you stop, you will be warned 
before the action completes.
When you stop the Server service, all users who are connected over the network to the computer are 
disconnected; therefore, it is a good idea to warn connected users before stopping the Server service.



Pause

Pauses a service that is running.
When you pause the Server service, only members of the computer's Administrator and of the Server Operators 
groups can make connections to the server.



Continue

Returns a service that has been paused to normal operation.



Startup

Enables you to specify the startup type of a service or to assign a logon account to a service.
To configure service startup, you must be logged on to a user account that has membership in the Administrators
local group.



HW Profiles

Enables or disables the selected service for a hardware profile.



Startup Parameters

Passes startup parameters to a service. A backslash (\) is treated as an escape character, so type two 
backslashes for each backslash in a parameter.



The Default Services

The services listed below are provided with Windows NT. In addition to these default services, other services may
be listed in the Services dialog box for a computer (for example, network transports or other services that have 
been installed on that computer).
For more information, click one of the following buttons:
 Alerter
 ClipBook Server
 Computer Browser
 Directory Replicator
 Event Log
 Messenger
 Net Logon
 Network DDE
 Network DDE DSDM
 NT LM Security Support Provider
 Remote Procedure Call (RPC) Locator
 Remote Procedure Call (RPC) Service
 Schedule
 Server
 Spooler
 UPS
 Workstation

{button ,AL("CPL_SRVMNG_ServicesPR;SM_SVC_Default")} Related Topics



Alerter service

Notifies selected users and computers of administrative alerts that occur on this computer. This service is used 
by the Server and other services, and requires the Messenger service.



ClipBook Server service

Supports ClipBook Viewer, which allows pages to be seen by remote ClipBooks.



Computer Browser service

Maintains an up-to-date list of computers, and provides the list to programs when requested. This service 
provides the computer lists that appear in the Select Computer and Select Domain dialog boxes.



Directory Replicator service

Replicates directories, and the files in those directories, between computers.



Event Log service

Records system, security, and program events in the event logs.



Messenger service

Sends and receives messages sent by administrators or by the Alerter service.



Net Logon service

For Windows NT Workstation, supports pass-through authentication of account logons. This services is used when
the workstation participates in a domain.
For Windows NT Server, performs authentication of account logons and keeps the domain's security database 
synchronized between the domain controller and the other Windows NT Servers of the domain.



Network DDE service

Provides a network transport as well as security for dynamic data exchange (DDE) conversations.



Network DDE DSDM service

Manages the shared DDE conversations. This service is used by the Network DDE service. DSDM stands for DDE 
Share Database Manager.



NTLM Security Support Provider service

Provides Windows NT security to remote procedure call (RPC) programs that use transports other than named 
pipes.



Remote Procedure Call (RPC) Locator Service

Allows distributed programs to use the Microsoft RPC name service. This service manages the RPC name service 
database.
The server side of a distributed program registers its availability with the RPC Locator service. The client side of 
a distributed program queries this service to find available compatible server programs.



Remote Procedure Call (RPC) service

This service is the RPC subsystem for Microsoft Windows NT, which provides the endpoint mapper and other 
miscellaneous RPC services.



Schedule service

Enables the AT command, which can be used to schedule commands and programs to run on a computer at a 
specified time and date.



Server service

Provides remote procedure call (RPC) support, as well as file, print, and named pipe sharing.



Spooler service

Provides print spooler services.



UPS service

Manages an uninterruptible power supply connected to this computer.



Workstation service

Provides network connections and communications.



Service Startup

Use this dialog box to configure when and how the service is started, and to specify the user account the service 
used to log on.
For more information, click one of the following buttons:
 Startup Type
 Automatic
 Manual
 Disabled
 Log On As
 System Account
 Allow Service to Interact with Desktop
 This Account
 Browse
 Password and Confirm Password

{button ,AL("SM_SVC_CONFIG")} Related Topics



Startup Type

Enables you to select the startup type of the service, as follows:
Automatic
Manual
Disabled



Automatic

Specifies whether the service should start automatically when the system starts. This service will start only if the
computer has 12MB or more of random access memory (RAM).



Manual

Allows the service to be started by a user or a dependent service.



Disabled

Prevents the service from being started by a user or a dependent service.



Log On As

Specifies whether services log on to the system account or a user account. Most services log on to a system 
account.
The Directory Replicator and Schedule services are usually the only default services provided with Windows NT 
that log on using other user accounts.



System Account

Specifies that the service will log on to the system account, rather than a user account. Most services log on to a
system account.



Allow Service to Interact with Desktop

Specifies whether you want the service to provide a user interface on a desktop that can be used by whoever is 
logged in when the service is started. This option can be used only if the service is running as a LocalSystem 
account (as defined in the This Account box).



This Account

Enables you to assign a logon user account to a service. Although most services must log on to the system 
account, some services can be configured to log on to special user accounts. 
The Directory Replicator and Schedule services are usually the only default services provided with Windows NT 
that log on using other user accounts.



Browse 

Enables you to select a user account after clicking This Account.



Password and Confirm Password

Provides places for you to type and confirm the password for the user account. This is the password that was 
assigned to the user account in User Manager.
Remember, passwords are case sensitive.



Service Hardware Profiles

Use this dialog box to enable and disable services when you boot the system using specific hardware profiles.
For more information, click one of the following buttons:
 Service
 Status
 Profile
 Enable
 Disable

{button ,AL("SM_SVC_HWProfilesPR")} Related Topics



Service

Shows the service that was selected in the Service list before you opened this dialog box. You can click any 
hardware profile shown in the Status box and enable or disable this service for that profile.



Status

Displays whether the service is enabled or disabled in a hardware profile. If Enabled is displayed in this column, 
this service is enabled when you boot the system using the associated hardware profile.



Profile

Displays hardware configurations you can select at startup. To enable or disable the service for a hardware 
profile, click the profile and then click Enable or Disable.
Use the System option in Control Panel to create hardware profiles and to set their order of preference.



Enable

Enables this service for a hardware profile.



Disable

Disables this service for a hardware profile.



Stopping Dependent Services

The listed services are dependent on the service that you are stopping. If you click OK, both the selected service
and its dependent services will be stopped.



Add User

Use this dialog box to select the user account the service will use to log on. This should be a user account 
created in User Manager specifically for logging on the service.
Make certain that the user account has the Password Never Expires option selected, and has membership in 
the appropriate groups. The particular group memberships assigned will depend on the operations that must be 
accomplished by the service.
For more information, click one of the following buttons:
 List Names From
 Names
 Add
 Search
 Add Name



List Names From

Shows the domain or computer from which the user account can be selected. The groups of that domain or 
computer are listed in the Names box.
When an asterisk (*) appears next to a domain or computer name in the List Names From box, this indicates 
that the local groups of that domain or computer can be listed in the Names box.



Names

Lists the user accounts of the domain or computer selected in the List Names From box.



Add

Adds the name selected in the Names box to the Add Name box.



Search

Searches for a particular user account.



Add Name

Specifies the account to which a service should log on. To specify an account, you can type the name here; click 
it in the Names box and then click Add; or click Search to find it.



Local Group Membership

This dialog box lists the user accounts and global groups that are members of the selected local group, as 
follows:

Members Of
Lists users accounts.

Members
Enables you to view the members of the selected global group.



Global Group Membership

This dialog box lists the user accounts that are members of the selected global group, as follows:

Members Of
Lists users accounts.



Server

Use this option in Control Panel to view and manage the server properties of this computer.
For more information, click one of the following buttons:
 Usage Summary
 Sessions
 Open Files
 File Locks
 Open Named Pipes
 Description
 Users
 Shares
 In Use
 Replication
 Alerts
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Usage Summary

Displays summaries of connections and resource usage for the computer.



Sessions

Displays the number of users remotely connected to the computer.



Open Files

Displays the number of files opened by connected users.



File Locks

Displays the number of file locks by connected users.



Open Named Pipes

Displays the number of open named pipes. A named pipe is an interprocess communication mechanism that 
allows one process to communicate with another local or remote process.



Description

Displays a description that helps you, system administrators, and other users identify the computer. This is an 
optional entry. It is appears in the Comment field of the computer's properties and Network Neighborhood. 
Typically, the description contains information such as the brand or model of the computer, the name of the 
computer's user, the user's telephone extension, the location of the computer, or a description of the computer's
function.



Users

Enables you to view a list of all the users connected over the network to the computer, and for one selected 
user, a list of all open resources.
You can disconnect one or all of the users who are connected to the computer.



Shares

Enables you to view a list of the computer's shared resources, and for one selected resource, a list of all the 
connected users. Optionally, you can disconnect one or all of the users who are connected to the computer.
To share directories or manage shared directories, use Windows NT Explorer or My Computer. To share printers or
manage shared printers, use My Computer.



In Use

Enables you to view a list of the computer's open shared resources.
You can close one or all open resources.



Replication

Enables you to manage directory replication for the computer. For a server, click this to specify the path to user 
logon scripts.
Directory replication exports copies of selected directories and files from this computer for storage on other 
computers, and imports selected directories and files from other computers for storage on this computer. 
Windows NT Server computers can export and import. Windows NT Workstation computers can only import.



Alerts

Enables you to view and manage the list of users and computers that are notified when administrative alerts 
occur at this computer.
Administrative alerts are generated by the system and relate to server and resource use. They warn about 
security and access problems, user session problems, server shutdown because of power loss when the UPS 
service is available, and printer problems.



User Sessions

Use this dialog box to view a list of all the network users connected to the computer, and a list of all the 
resources opened by a selected user. Optionally, you can disconnect one or all of the users connected to the 
computer.
For more information, click one of the following buttons:
 Connected Users
 Computer
 Opens (for Connected Users)
 Time (for Connected Users)
 Idle
 Guest
 Number of Connected Users
 Resource
 Opens (for Resource)
 Time (for Resource)
 Disconnect
 Disconnect All

{button ,AL("SM_PROP_Sessions")} Related Topics



Connected Users    

Lists the network users who are connected to the computer.
Each entry consists of a user account icon, followed by a user name and a computer name. In some cases the 
user's computer name may appear instead of the user name.



Computer

Displays the computer name of the user's computer.



Opens

Displays the number of resources opened on this computer by this user.



Time

Displays the hours and minutes that have elapsed since this session was established.



Idle

Displays the hours and minutes that have elapsed since this user last initiated an action.



Guest

Specifies whether this user is connected to this computer as a guest (shown as Yes or No).



Connected Users

Displays the total number of users remotely connected to the computer.



Resource

Lists the shared resources to which the selected user is connected. Each entry consists of an icon indicating the 
type of resource, followed by the share name. A shared resource could be:

A shared directory
A named pipe
A shared printer
A resource of an unrecognized type

In some cases, a connection to a printer is monitored here as a connection to a named pipe.



Opens

Displays the number of opens from the listed resource for the selected user.



Time

Displays the hours and minutes that have elapsed since this user first connected to the shared resource.



Disconnect

Enables you to disconnect one user from the computer by clicking a user name in the Connected Users list and
then clicking this button.
Disconnecting a user who is using resources can result in loss of data. It is a good idea to warn connected users 
before disconnecting them.
While you are administering another computer remotely, your user account is listed as a user connected to the 
IPC$ resource. It will not be disconnected.



Disconnect All

Enables you to disconnect all users from the computer.
Disconnecting users who are using resources can result in loss of data. It is a good idea to warn connected users 
before disconnecting them.
While you are administering another computer remotely, your user account is listed as a user connected to the 
IPC$ resource. It will not be disconnected.



Shared Resources

Use this dialog box to view a list of the shared resources available on the computer, and for a selected resource, 
a list of connected users. Optionally, you can disconnect one or all of the users connected to the computer.
To share directories or manage shared directories, use Shared Directories on the Server Manager Computer 
menu, or use Windows NT Explorer. To share printers or manage shared printers, use the Printers folder.
For more information, click one of the following buttons:
 Sharename
 Uses
 Path
 Connected Users
 Time
 In Use
 Number of Connected Users
 Disconnect button
 Disconnect All button

{button ,AL("SM_PROP_SHARES;SM_SHARE_DescrSpecial")} Related Topics



Sharename

Lists the shared resources available on the computer. Each entry consists of an icon representing the type of 
shared resource, followed by the share name. In some cases, a connection to a printer is monitored here as a 
connection to a named pipe.
A shared resource could be:

A shared directory
A named pipe
A shared printer
A communication-device queue (Microsoft LAN Manager servers only)
A resource of an unrecognized type



Uses

Displays the number of connections to the shared resource.



Path

Displays the path of the shared resource.



Connected Users    

Lists the users who are connected to the selected shared resource. Each entry consists of a user account icon, 
followed by a user name. In some cases the user's computer name may appear instead of the user name.



Time

Displays the hours and minutes that have elapsed since the user first connected to the selected shared resource.



In Use

Specifies whether the user currently has a file open from the selected shared resource (shown as Yes or No).



Connected Users

Displays the total number of users connected to the selected shared resource.



Disconnect

Enables you to disconnect one user from all shared resources by clicking the name in the Connected Users list,
and then clicking this button.
Disconnecting a user who is using resources can result in loss of data. It is a good idea to warn connected users 
before disconnecting them.
While you are administering another computer remotely, your user account is listed as a connected user for the 
IPC$ share. It will not be disconnected.



Disconnect All

Enables you to disconnect all users from all shared resources.
Disconnecting users who are using resources can result in loss of data. It is a good idea to warn connected users 
before disconnecting them.
While you are administering another computer remotely, your user account is listed as a connected user for the 
IPC$ share. It will not be disconnected.



Special Shares

A computer's shared resources include those resources (such as directories) that have been shared by a user or 
an administrator, plus any special shares that may have been created by the system.
Depending on the configuration of the computer being administered, some or all of the following special shares 
may appear when Windows NT presents a list of the computer's shared resources. These shares are created by 
the system. In most cases, these special shares should not be deleted or modified.
For more information click one of the following buttons:
   driveletter  $  
 ADMIN$
 IPC$
 PRINT$
 REPL$
 NETLOGON
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driveletter$

A share which allows administrative personnel to connect to the root directory of a storage device. Shown as A$, 
B$, C$, D$, and so on. For example, D$ is a share name by which drive D might be accessed by an administrator 
over the network.
For a Windows NT Workstation computer, only members of the Administrators and Backup Operators can connect
to these shares. For a Windows NT Server computer, members of the Server Operators group can also connect to
these shares.



ADMIN$

A resource used by the system during remote administration of a computer. The path of this resource is always 
the path to the Windows NT system root (the directory in which Windows NT is installed: for example, C:\Winnt).
For a Windows NT Workstation computer, only members of the Administrators and Backup Operators can connect
to this share. For a Windows NT Server computer, members of the Server Operators group can also connect to 
this share.



IPC$

A resource sharing the named pipes that are essential for communication between programs. Used during 
remote administration of a computer, and when viewing a computer's shared resources.



PRINT$

A resource used during remote administration of printers.



REPL$

A resource created by the system when a Windows NT Server computer is configured as an replication export 
server. It is required for export replication.
This resource is only provided for Windows NT Server computers which are configured as replication export 
servers. It is not provided for Windows NT Workstation computers.



NETLOGON

A resource used by the Net Logon service of a Windows NT Server computer while processing domain logon 
requests.
This resource is only provided for Windows NT Server computers. It is not provided for Windows NT Workstation 
computers.



Open Resources

Use this dialog box to view a list of the computer's open shared resources. Or, you can close one open resource 
or all open resources.
For more information, click one of the following buttons:
 Open Resources
 File Locks
 Opened By
 For
 Locks
 Path
 Refresh
 Close Resource
 Close All Resources

{button ,AL("SM_PROP_INUSE")} Related Topics



Open Resources

Displays the total number of resources that are open on the computer.



File Locks

Displays the total number of file locks on open resources.



Opened By

Lists the computer's open resources. Each entry consists of an icon representing the type of resource, followed 
by the user name (or sometimes the computer name) of the user who has opened the resource. An open 
resource could be:

A file
A named pipe
A print job in a print spooler
A resource of an unrecognized type

In some cases, a print job is shown here as an open named pipe.



For

Displays the permission granted when the resource was opened.



Locks

Displays the number of locks on the resource.



Path

Displays the path of the open resource.



Refresh

Updates the display with current information.



Close Resource

Enables you to close a selected resource.
It is a good idea to warn connected users before closing resources. If you do not, they may lose data.
While you are administering another computer remotely, your connection is displayed here as an open named 
pipe. It will not be closed.



Close All Resources

Enables you to close all resources that are open on the computer.
It is a good idea to warn connected users before closing resources. If you do not, they may lose data.
While you are administering another computer remotely, your connection is displayed here as an open named 
pipe. It will not be closed.



Directory Replication

Use this dialog box to manage replication properties for the computer, and to specify a local path to user logon 
scripts.
For more information, click one of the following buttons:
 Do Not Export
 Export Directories
 Manage button (under Export Directories)
 From Path
 To List
 Do Not Import
 Import Directories
 Manage button (under Import Directories)
 To Path
 From List
 Add button
 Remove button
 Logon Script Path
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Do Not Export

Prevents replication from this computer. Subdirectories are not exported.



Export Directories

Enables replication from this computer. Subdirectories of the From Path are exported.



Manage (under Export Directories)

Displays the Manage Exported Directories dialog box, where export locks can be added or removed, and 
export stabilization and subtree export can be enabled or disabled.



From Path

A local path to a directory from which subdirectories and files are exported.
The default From Path is C:\systemroot\System32\Repl\Export. If Windows NT is installed in a location other than 
C:\systemroot, the system adjusts the default accordingly. Usually, you will not need to change the default From 
Path.



To List

Exports the subdirectories from this export server to the domains and computers listed here.
By default, the To List contains no entries and this computer automatically exports to the local domain. 
However, if you add any entries to the To List, the computer will no longer automatically export to the local 
domain. To export to the local domain when there are entries in the To List, the domain name must be explicitly 
added to the To List.
Replication to a domain name does not always succeed when some or all import computers of that domain are 
separated from this export server by a wide area network (WAN) bridge. In this situation, you must explicitly add 
the computer names of those import computers to this list.



Do Not Import

Prevents replication to this computer. Subdirectories are not imported.



Import Directories

Allows replication to this computer. Subdirectories are imported.



Manage (under Import Directories)

Displays the Manage Imported Directories dialog box, where import locks can be added or removed.



To Path

A local path to a directory in which imported subdirectories and files are stored.
The default To Path is C:\systemroot\System32\Repl\Import. If Windows NT is installed in a location other than C:\
systemroot, the system adjusts the default accordingly. Usually, you will not need to change the default To Path.



From List

Replicates subdirectories to this import computer from the domains and computers listed here.
By default, the From List contains a no entries and this computer automatically imports from the local domain. 
However, if you add any entries to the From List, the computer will no longer automatically import from the 
local domain. To import from the local domain when there are entries in the From List, the domain name must 
be explicitly added to the From List.
Replication from a domain name does not always succeed when the export servers of that domain are separated
from this computer by a wide area network (WAN) bridge. In this situation, you must explicitly add the computer 
names of those export servers to this list.



Add

Displays the Select Domain dialog box.
The Add button under Export Directories is used to add a computer name or domain name to the To List. The 
Add button under Import Directories is used to add a computer name or domain name to the From List.



Remove

Removes a selected computer name or domain name from the list.
Click the Remove button under Export Directories to remove a computer name or domain name from the To 
List. Click the Remove button under Import Directories to remove a computer name or domain name from the 
From List.



Logon Script Path

A local path to a directory where logon scripts are stored. When a server authenticates a logon request and that 
user account has a logon script assigned, the system locates the logon script by combining the local path 
specified here, with a filename (and optionally a relative path) specified in User Manager.
For a domain, master copies of every logon script should be stored under one replication export directory of a 
Windows NT Server computer. Copies of these master logon scripts should be replicated to the other servers of 
the domain. Then, for each Windows NT Server computer, the local path to imported logon scripts should be 
entered here, in the Logon Script Path box.
Usually, you will enter a path to a \Scripts subdirectory of the replication To Path. For example, C:\systemroot\
System32\Repl\Import\Scripts. An entry is required. Do not leave this box blank.



Directory Replication

Use the Directory Replication dialog box to manage replication properties for the computer.
For more information, click one of the following buttons:
 Do Not Import
 Import Directories
 Manage button (under Export directories)
 To Path
 From List
 Add
 Remove

{button ,AL("SM_PROP_REPL_IMPORT")} Related Topics



Add

Displays the Select Domain dialog box. This is used to add a computer or domain to the From List.



Remove

Removes a selected computer or domain from the From List.



Manage Exported Directories

Use this dialog box to add or remove export locks, and to enable or disable export stabilization and subtree 
export.
For more information, click one of the following buttons:
 Export Path
 Subdirectory
 Locks
 Stabilize
 Subtree
 Locked Since
 Export Settings For
 Add Lock
 Remove Lock
 Wait Until Stabilized
 Entire Subtree
 Add
 Remove

{button ,AL("CPL_SRVMNG_ManagePR")} Related Topics



Export Path

Displays the path to the directory from which subdirectories and files are exported.



Subdirectory

Lists the subdirectories that are exported from this computer. When a subdirectory is created in the export path 
(using Windows NT Explorer or My Computer), it is automatically added to this list.



Locks

Displays the number of locks applied to the subdirectory.
A lock prevents subdirectory export, and more than one lock might be applied to a subdirectory. Export occurs 
only if this column has a value of zero.



Stabilize

Yes indicates that all files and subdirectories in that subdirectory tree must be stable (cannot be changed) for 
two minutes (or more) before replication can occur.
No (the default) indicates that each file can be replicated as soon as it is changed. 



Subtree

Yes (the default) indicates that the entire subdirectory tree will be exported.
No indicates that only the first-level subdirectory will be exported.



Locked Since

Displays the date and time that the oldest lock was placed on this subdirectory.



Export Settings For

Shows the name of the selected subdirectory.



Add Lock

Adds a lock to the selected subdirectory, preventing export.



Remove Lock

Removes a lock from the selected subdirectory. Export only occurs when a subdirectory has zero locks.



Wait Until Stabilized

If selected, specifies that no changes can be made for two minutes (or more) to any subdirectory or file in the 
selected subdirectory tree before replication can occur. This helps to eliminate partial replication. If cleared, 
specifies that each file can be replicated as soon as it is changed.
The current setting appears in the Stabilize column.



Entire Subtree

If selected, specifies that the first-level export subdirectory and its files will be exported, along with all its 
subdirectories and their files. If cleared, specifies that only the first-level export subdirectory and its files will be 
exported.
This current setting appears in the Subtree column.



Add

Displays the Add Subdirectory dialog box, which is used to add new subdirectories to the list of exported 
subdirectories.
However, this is usually unnecessary because it only adds an entry to the list, and does not actually create the 
subdirectory. When a subdirectory is created in the export path (using Windows NT Explorer or My Computer), it 
is automatically added to the list.



Remove

Removes the selected subdirectory from the list of exported subdirectories.
However, this is usually unnecessary because it only removes the entry in the list, not the actual subdirectory. If 
that subdirectory still exists in the export path, it will still be exported and will later reappear in this list.



Manage Imported Directories

Use this dialog box to add or remove import locks.
For more information, click one of the following buttons:
 Import Path
 Subdirectory
 Locks
 Status
 Last Update
 Locked Since
 Import Settings For
 Add Lock
 Remove Lock
 Add
 Remove
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Import Path

Displays the path to the directory in which replicated subdirectories and files are stored.



Subdirectory

Lists the replicated subdirectories that are imported to this computer.
A subdirectory is automatically imported if it is exported by one of the export servers or domains in the From 
List of the Directory Replication dialog box. If it is imported, it is automatically added to this list.



Locks

Prevents import to the subdirectory. More than one lock might be applied to a subdirectory. Import to a 
subdirectory only occurs if this column has a value of zero.



Status

OK indicates that the subdirectory is receiving regular updates from an export server and the imported data is 
identical to that exported.
No Master indicates that the subdirectory is not receiving updates. The export server might not be running, or 
the export server might have stopped exporting updates.
No Sync indicates that the subdirectory has received updates, but the data is not up to date. This could be due 
to a communications failure, open files on the import computer or export server, the import computer not having
access permissions at the export server, or an export server malfunction.
A blank entry indicates that replication has never occurred for that subdirectory. Replication may not be properly 
configured for this import computer, for the export server, or both.



Last Update

Displays the date and time that the last update was made to a file in this import subdirectory, or in its subtree.



Locked Since

Displays the date and time that the oldest lock was placed on this subdirectory.



Import Settings For

Shows the name of the selected subdirectory.



Add Lock

Adds a lock to the selected subdirectory, preventing import.



Remove Lock

Removes a lock from the selected subdirectory. Import only occurs when a subdirectory has zero locks.



Add

Displays the Add Subdirectory dialog box, which is used to add new subdirectories to the list of imported 
subdirectories.
However, this is usually unnecessary, because this adds the entry to the list, and does not add the actual 
subdirectory.



Remove

Removes the selected subdirectory from the list.
However, this is usually unnecessary, because this only removes the entry from the list, and does not remove 
the actual subdirectory.



Add Subdirectory

Use this dialog box to add a subdirectory to the Subdirectory list.
However, this is usually unnecessary, since this action only adds an entry to the list and does not create the 
actual subdirectory. Instead, use Windows NT Explorer or My Computer prompt to create export subdirectories on
export servers. On import computers, imported subdirectories are automatically created the first time they are 
received from an exporting server.

Path
This is either the import path or the export path.

Subdirectory Name
Provides a place for you to type the subdirectory name.



Alerts

Use this dialog box to view and manage the list of users and computers that are notified when administrative 
alerts occur at this computer. 
For alerts to be sent, the Alerter and Messenger services must be running on the computer originating the alert. 
For alerts to be received, the Messenger service must be running on the destination computer.
For more information, click one of the following buttons:
 New Computer or Username
 Send Administrative Alerts To
 Add
 Remove
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New Computer Or Username

Provides a place for you to type a user name or computer name that you want to add to the list of alert 
recipients.



Send Administrative Alerts To

Lists the computers and users who are notified when administrative alerts occur at this computer.



Add

Adds the user name or computer name to the list of alert recipients that are specified in the New Computer Or 
Username box.



Remove

Removes a user or computer from the list of alert recipients that are specified in the Send Administrative 
Alerts To box.



Select Domain

Use this dialog box to select a domain or a computer to be added to the replication From List or the replication 
To List.
Replicating to or from a domain name is a convenient way to set up directory replication between many 
computers, because each export server and import computer can specify only a few domain names for export or 
import, rather than a long list of many computer names.

Domain
Displays the current domain. You can type a domainname or a \\computername here.

Select Domain
Lists the available domains. If you double-click on a domain name, the computers in that domain are listed. You 
can select one of the listed domains or computers.



Close Resources

Closing resources can result in loss of data. It is a good idea to send a warning to connected users before closing 
resources.



Close

Closing resources can result in loss of data. It is a good idea to send a warning to connected users before closing 
resources.



Disconnect

Disconnecting users can result in loss of data. It is a good idea to send a warning to connected users before 
disconnecting them.



Find Account

Use this dialog box to locate a particular user account or group.
For more information, click one of the following buttons:
 Find User or Group
 Search All
 Search Only In
 Search
 Search Results
 Add



Find User or Group

Provides a place for you to specify the name you want to search for. The system will search for user accounts or 
groups having that exact name.



Search All

When selected, this option starts a search for a matching user name or group in the local domain or computer, 
and in all domains trusted by the local domain.



Search Only In

When selected, this option starts a search for a matching user name or group in the domains and computers 
selected from the list. The list includes the local domain or computer, and all domains trusted by the local 
domain.
One or more domains and computers can be selected from the list.



Search

Begins a search based on the parameters specified in the Find User Or Group box, and by the Search All and 
Search Only In options.



Search Results

Contains a list of user accounts and groups found during a search. This list is filled as a search progresses.
One or more names can be selected from the Search Results list, and then added to the Add Name list of the 
Add User dialog box by clicking Add in the Find Account dialog box.
The list presents the matching users in the form domainname\username (full name) description or 
computername\username (full name) description.
The list presents the matching groups in the form domainname\groupname description or computername\
groupname description.



Add

Closes the Find Account dialog box, and adds the accounts selected in the Search Results list to the Add Name 
list of the Add User dialog box.
If the results list is empty, or if no user accounts or groups are selected in the results list, the Add button is 
unavailable.



Directory Replication

Directory replication is the duplication of a master set of directories from a server (called an export server) to 
specified servers or workstations (called import computers) in the same or other domains. A Windows NT Server 
computer can be an export server, an import computer, or both. A Windows NT Workstation computer can only 
be an import computer.
Replication simplifies the task of maintaining identical sets of directories and files on multiple computers, 
because only a single master copy of the data must be maintained. Once replication is set up, replication occurs 
each time a change is made to one of the files in a directory set for export.



Directory Replicator service

Before replication can occur, an appropriate logon account must be assigned to the Directory Replicator service 
of each computer that will participate in replication.
From a Windows NT Server computer, use User Manager for Domains to create a domain user account that the 
Directory Replicator service will use to log on. This account must have the Password Never Expires option 
selected, all logon hours allowed, and membership in the domain's Backup Operators group.
For each computer that will participate in replication, use the Server option in Control Panel to configure the 
Directory Replicator service to start up automatically, and to log on using the user account described above.



Administrative alerts are generated by the system, and relate to server and resource use. They warn about 
security and access problems, user session problems, server shutdown because of power loss when the UPS 
service is available, and printer problems.



Close Resources

Closing resources can result in loss of data. It is a good idea to send a warning to connected users before closing 
resources.



Close

Closing resources can result in loss of data. It is a good idea to send a warning to connected users before closing 
resources.



Disconnecting a User

Although disconnecting a user who is not using resources does not result in loss of data, it is a good idea to send 
a warning to connected users before disconnecting them. 



Disconnecting a User Who is Using Resources

Disconnecting a user who is using resources can result in loss of data. It is a good idea to send a warning to 
connected users before disconnecting them.



Disconnecting Users

Although disconnecting users who are not using resources does not result in loss of data, it is a good idea to 
send a warning to connected users before disconnecting them.



Disconnecting Users Who are Using Resources

Disconnecting users who are using resources can result in loss of data. It is a good idea to send a warning to 
connected users before disconnecting them.



Disconnecting All Users

Although disconnecting users who are not using resources does not result in loss of data, it is a good idea to 
send a warning to connected users before disconnecting them.



Disconnecting All Users Who are Using Resources

Disconnecting users who are using resources can result in loss of data. It is a good idea to send a warning to 
connected users before disconnecting them.



Disconnecting a Computer

Although disconnecting a computer that is not using resources does not result in loss of data, it is a good idea to 
send a warning to users on connected computers before disconnecting them. 



Disconnecting All Computers

Disconnecting all computers can result in loss of data for those computers using resources. It is a good idea to 
send a warning to users on connected computers before disconnecting them. 



To manage server properties

1 Click here        to display Server.
2 To change the computer description, type new text in the Description box.
3 To change server properties, click Users, Shares, In Use, Replication, or Alerts.

Tip
The computer description, which is an optional entry, appears in the Comment field of the computer's 

properties and Network Neighborhood. This description helps you, system administrators, and other users 
identify the computer.
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To view a list of users connected to the computer

1 Click here        to display Server.
2 Click Users.
3 To view the resources opened by one user, click a user name in the Connected Users box.
4 To disconnect one user, click the user name in the Connected Users box, and then click Disconnect.

Or, to disconnect all users, click Disconnect All.

Tip
Disconnecting users who are using resources may result in loss of data. It is a good idea to warn connected

users before disconnecting them.
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To view a list of the computer's shared resources

1 Click here        to display Server.
2 Click Shares.
3 To view the users connected to a shared resource, click a share name in the Sharename box.
4 To disconnect one user from all shared resources, click the user name in the Connected Users box and then 

click Disconnect.
Or, to disconnect all users from all shared resources, click Disconnect All.

Tip
Disconnecting users who are using resources may result in loss of data. It is a good idea to warn connected

users before disconnecting them.
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To view a list of the computer's open shared resources

1 Click here        to display Server.
2 Click In Use.
3 To close an open resource, click the resource in the Opened by list, and then click Close Resource.

Or, to close all open resources, click Close All Resources.
4 If needed, click Refresh to update the Opened by list.

Notes
Closing resources may result in loss of data. It is a good idea to warn connected users before closing 

resources.
When you are administering another computer remotely, your connection appears here as an open named 

pipe. It cannot be closed.
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To set up an export server

1 Use My Computer or Windows NT Explorer to create the directories that will be exported.
2 Click here        to display Server.

3 Click Replication.
4 Click Export Directories.
5 To change the path from which subdirectories will be exported, type a local path in the From Path box.
6 Under Export Directories, click Add, and then specify to which domain or computer to export 
subdirectories.
7 To stop exporting subdirectories to a domain or computer, under Export Directories, click the domain or 
computer in the To List, and then click Remove.

8 To manage locks, stabilization, and subtree replication for the subdirectories exported from this computer, 
under Export Directories, click Manage, and then make the appropriate entries in the dialog box that 
appears.

9 In the Directory Replication dialog box, click OK.
If it does not already exist, the system creates the share REPL$, which is required for export replication. If it is 
not already running, the system starts the Directory Replicator service.

Notes
Only Windows NT Server computers can be set up as replication export servers; Windows NT Workstation 

computers cannot.
Make sure an appropriate logon account has been assigned to the Directory Replicator service before 

performing this procedure.
The directories to be exported must be subdirectories of the replication From Path. You can add the files 

to be exported to these subdirectories. However, this is optional. Once you set up replication, any files later added 
to these subdirectories will be exported automatically. You can also later add additional subdirectories to the From 
Path.

By default, the To List contains no entries and this computer automatically exports to the local domain. 
However, if you add any entries to the To List, the computer will no longer automatically export to the local 
domain. To export to the local domain then, the domain name must be explicitly added to the To List.
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To set up an import computer

1 Click here        to display Server.
2 Click Replication.
3 Click Import Directories.
4 To change the path in which imported subdirectories will be stored, type a local path in the To Path box.
5 Under Import Directories, click Add, and then specify from which domain or export server to import 

subdirectories.
6 To stop importing subdirectories from an export server or domain, click the domain or computer name in the 

From List, and then click Remove.
7 To view a list of the subdirectories that have been imported to this computer, or to manage locks on those 

imported subdirectories, click Manage.

Tips
When you finish this procedure, the system starts the Directory Replicator service if it's not running 

already.
Make sure an appropriate logon account has been assigned to the Directory Replicator service before 

performing the procedure.
Both Windows NT Server computers and Windows NT Workstation computers can be set up as import 

computers.
By default, the From List contains a no entries and this computer automatically imports from the local 

domain. However, if you add any entries to the From List, the computer will no longer automatically import from 
the local domain. To import from the local domain then, the domain name must be explicitly added to the From 
List.
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To manage locks, stabilization, and subtree replication for the subdirectories exported from this 
computer

1 Click here        to display Server.
2 Click Replication,
3 Under Export Directories, click Manage.
4 To temporarily stop exporting a subdirectory, click the subdirectory and then click Add Lock.

Or, to resume exporting a locked subdirectory, click the subdirectory and then click Remove Lock.
5 To export a subdirectory and all the subdirectories in its tree, click the subdirectory and then select the Entire 

Subtree check box. 
Or, to export only the highest subdirectory in a tree, click the subdirectory and then click to clear this check 
box.

6 To specify a two-minute or longer delay during which no changes can be made before files are exported, click 
a subdirectory and then select the Wait Until Stabilized check box.
Or, to export files immediately after they are changed and saved, click a subdirectory and then click to clear 
this check box.

Notes
Usually, you should only remove locks that you have applied. Exporting resumes only when the Locks 

column shows a value of 0 for the subdirectory.
Click Add to add a subdirectory to the list. Click Remove to remove the selected subdirectory from the 

list.
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To view a list of, or manage locks for, imported subdirectories

1 Click here        to display Server.
2 Click Replication,
3 Under Import Directories, click Manage.
4 To temporarily stop importing to a subdirectory, click the subdirectory and then click Add Lock.
5 To resume importing to a locked subdirectory, click the subdirectory and then click Remove Lock.

Notes
Usually, you should only remove locks that you have applied. Import resumes only when the Locks column

shows a value of 0 for the subdirectory.
Click Add to add a subdirectory to the list. Click Remove to remove the selected subdirectory from the 

list.
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To set the logon script path for a server

1 Click here        to display Server.
2 Click Replication.
3 In the Logon Script Path box, type a local path.

This requires an entry. Do not leave this box blank.

Notes
Typically, you would enter a path to a \Scripts subdirectory of the replication To Path. For Windows NT 

Workstation computers, you cannot change the logon script path from the default (usually, systemroot\System32\
Repl\Import\Scripts).

When a server authenticates a logon request and that user account has a logon script assigned, 
Windows NT locates the logon script by combining a local logon script path specified using the Server option in 
Control Panel with a filename (and optionally a relative path) as specified in User Manager.

Make sure you store master copies of every a logon script for a domain under one replication export 
directory of one Windows NT Server computer. Copies of these scripts can then be replicated to the other servers of 
the domain. Then, for each Windows NT Server computer, enter the path to the imported logon scripts in the Logon
Script Path of the Directory Replication dialog box.
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A logon script is an optional file that runs each time a user logs on. The script can exist in the form of a batch file
(.bat or .cmd filename extension) or an executable program (.exe filename extension). 
A logon script path is a local path that points to the directory where logon scripts are stored.



To manage the list of administrative alert recipients

1 Click here        to display Server.
2 Click Alerts.
3 To add a user or computer to the list of alert recipients, type the user name or computer name in the New 

Computer or Username box, and then click Add.
Or, to remove a user or computer from the list of alert recipients, click the user name or computer name in the
Send Administrative Alerts To box, and then click Remove.

Notes
Administrative alerts related to server and resource use are generated by the system. These alerts warn 

about security and access problems, user session problems, server shutdown (due to power loss when the UPS 
service is available), and printer problems.

For alerts to be sent, the Alerter and Messenger services must be running on the computer originating the 
alert. For alerts to be received, the Messenger service must be running on the destination computer.



To start, stop, pause, or continue a service

1 Click here        to display Services.
2 Click the service.
3 Click Start, Stop, Pause, or Continue.

Notes
Optionally, to pass startup parameters to a service, type the parameters in the Startup Parameters box 

before clicking Start. A backslash (\) is treated as an escape character, so type two backslashes for each backslash 
in a parameter.

When you pause the Server service, only users in the computer's Administrators and the Server Operators 
groups will be able to make new connections to the computer.

When you stop the Server service, all users who are connected over the network to the computer are 
disconnected. It is a good idea to pause the Server service and warn all connected users beforehand.

Once you stop a Server service, the affected computer can no longer be administered remotely. Therefore, 
the Server service can only be restarted locally.
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To configure startup for a service

1 Click here        to display Services.
2 Click the service.
3 Click Startup.
4 Under Startup Type, click a startup type of Automatic, Manual, or Disabled.
5 To specify the user account the service can use to log on, click System Account or This Account.
6 If you click This Account, click the browse button , specify a user account, and then type the password for 

the user account in both the Password and Confirm Password boxes.
7 To provide a user interface on a desktop that can be used by whoever is logged in when the service is started, 

select the Allow Service to Interact with Desktop check box.

Notes
To configure service startup, you must be logged on to a user account that has membership in the 

Administrators local group.
Allow Service to Interact with Desktop is available only if the service is running as a LocalSystem 

account (as specified in the This Account box).
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To enable or disable a service for a hardware profile

1 Click here        to display Services.
2 Click the service and then click HW Profiles.
3 Click the hardware profile to configure.
4 Click Enable or Disable.

Note
Use the System option in Control Panel to create hardware profiles and to set their order of preference.
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